
CATIA Solutions Version 5 Release 20 
Product Enhancement Overview

Infrastructure Solutions
●     CATIA Infrastructure User Guide

●     Data Exchange Interfaces

●     MULTICAx AD Plug-in

●     MULTICAx ID Plug-in

●     MULTICAx Pro/Engineer Plug-in

●     MULTICAx SolidEdge Plug-in

●     MULTICAx Unigraphics Plug-in

●     Photo Studio

●     Product Structure

●     Real Time Rendering

●     SmarTeam - CATIA Integration

●     SmarTeam - CATIA Supply Chain Engineering Exchange

●     V4 Integration

●     VPM Supply Chain Engineering Exchange

Mechanical Design Solutions
●     2D Layout for 3D Design

●     3D Functional Tolerancing & Annotation

●     Aerospace Sheetmetal Design

●     Cast & Forged Part Optimizer

●     Composites Design

●     Core and Cavity Design

●     Functional Molded Part

●     Generative Sheetmetal Design

●     Generative Drafting

●     Healing Assistant

●     Interactive Drafting

●     Mold Tooling Design

●     Part Design

●     Sketcher

●     Structure Design

●     Wireframe and Surfaces



Shape Design & Styling Solutions
●     Digitized Shape Editor

●     FreeStyle Shaper Optimizer & Profiler

●     Generative Shape Design

●     Imagine & Shape

●     Quick Surface Reconstruction

●     Shape Sculptor

Analysis
●     Advanced Meshing Tools

●     Generative Structural Analysis

●     Nonlinear Structural Analysis and Thermal Analysis

Equipment & Systems Engineering Solutions
●     Electrical Harness Flattening

●     Electrical Harness Installation

●     Ship Structure Detail Design

●     Structure Functional Design

Machining Solutions
●     3 Axis Surface Machining

●     Advanced Machining

●     DPM Process and Resource Definition

●     Lathe Machining

●     Multi-Axis Surface Machining

●     Multi-Pocket Machining

●     Multi-Slide Lathe Machining

●     NC Machine Tool Builder

●     NC Machine Tool Simulation Machining

●     NC Manufacturing Infrastructure

●     Prismatic Machining

●     Prismatic Machining Preparation Assistant

●     STL Rapid Prototyping

Product Synthesis Solutions
●     3D Insight

●     DMU Kinematics Simulator

●     Human Activity Analysis



●     Human Builder

●     Human Measurements Editor



Infrastructure

New Functionality

Fonts
DS ISO1 Open Type font is now provided to display annotations with respect to the various ISO standards defining 
text representations.

Enhanced Functionalities

Configuring Printer Drivers
Ability to embed or link fonts when generating PDF documents. 

Digital Rights Management (DRM)
Full support of AD-FS. 
Full offline feature. 
Support of CATProcess and CATAnalysis formats.

Reversing Actions
Ability to flush the history.

Running Batches Using the Batch Monitor
More batches are available.

Printing Documents
Implementation of DRM.

Capturing Images
Implementation of DRM.

Recording Interactions in Video Format
Implementation of DRM.

Running the PrintBatch
Implementation of DRM.

Customizing

Fonts
Support of TrueType Collection fonts and font linking mechanism.  
 

Digital Rights Management
Ergonomic enhancements have been made to provide the ability to switch anytime between a basic view and an 
advanced view.

PCS
A new option enables to prevent any unpredictable behavior in the Undo/Redo process if a document is open in 
several editors for modification purpose.
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Data Exchange Interfaces

Enhanced Functionalities

DXF 
It is now possible to import a file DXF/DWG into 2D Layout for 3D Design. 
Autocad 2009 is supported.

Customizing Settings

STEP: Global nested assembly or Partial nested assembly 
Let you activate a global or a partial export of nested assemblies. 

STEP: 3D Annotations 
Lets you import/export 3D annotations. 

COPS validation properties 
COPS validation properties handle the points on edge (sharp sampling points) in addition to the points on surface. 
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MULTICAx AD Plug-in

Enhanced Functionalities

3D DXF
3D Faces are now supported in DXF files (existing limitation in documentation removed). 
DXF 3D AutoCad 2007 is now supported.
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MULTICAx ID Plug-in

Enhanced Functionalities

IDI NX5 (MS 13) and NX6 are now supported.

Product Enhancement Overview Version 5 Release 20



MULTICAx PD Plug-in

Enhanced Functionalities

ProE WF4 is now supported.
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MULTICAx SE Plug-in

Enhanced Functionalities

SolidEdge assemblies are now supported.
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MULTICAx UD Plug-in

Enhanced Functionalities

UG NX4 and UG NX5 are now supported.

Removed Functionalities

Indirect mode is no longer available.
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Photo Studio

Enhanced Functionality

Using Materials for Renderings
A new shader type Architectural & Design is added. The round corner option enables you to create visual effect of 
rounded corners on sharp and straight edges. 
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Product Structure

Enhanced Functionality

Product Structure Package
The LocationX, LocationY and LocationZ attributes are added for Assembly, Part and Product types to display the X, 
Y and Z coordinates of the instance location relative to its parent (based on the position matrix).

Product Enhancement Overview Version 5 Release 20



Real Time Rendering

Customizing Settings

Material
A new option enables you synchronize automatically material parameters and applied materials after a PowerCopy.
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SmarTeam CATIA Integration

●     Large Assembly & Concurrent Design:
�❍     Global Refresh: Enables you to update a complete CATIA product, applying the latest available revisions to all of the 

products children.

�❍     Design Compare: Allows the opening of several versions of the same CATIA Part or CATIA Product within a CATIA 
session, helping the designer to integrate the preferred version into the final project.

●     Releasing a checked-in document using Job Server: If Job Server is implemented on your system, CATIA documents can 
now be released directly from SmarTeam - Editor without the need for a CATIA installation on your machine.

●     SmarTeam Document Status in the CATIA Document Node Tooltip: 
The SmarTeam Document status has been added to the tooltip of the CATIA document Node. 

●     Save as Type option: The new Save as Type option saves the current document into the SmarTeam database in a 
different format and optionally links it to the master CATIA document used to create this document. This safely saves 
the created document to SmarTeam, eliminating the possibility of mistakes when manually defining the file type and 
linking it to a specific revision.

●     Tools Options - Some environment variables have been removed and their purpose is now exposed SmarTeam (CAI) 
tools options tab: 

�❍     Display the Smarteam Project Manager window the first time a Save to SmarTeam operation is performed even if 
the root object was previously saved. 

�❍     Prevent the SmarTeam Save operation from loading the context during the update of design links, in order to 
improve performance and memory consumption. 

�❍     Allow the Check-Out/New-Release operation on non-latest revision. 

�❍     Send the instances activity information to SmarTeam to compute the Quantity attribute based on this information. 

●     Non-latest available icon: The non-latest available icons have been updated. 

●     Batch for instance exposure: Using the SmarTeam 3D Live Open In Catia functionality, a 3D Live user can load specific 
parts/products from an assembly in a CATIA session. In order to work, the instances information of the assembly must 
be stored in the SmarTeam database. After the information is stored, CATIA can provide SmarTeam with this 
information when saving an assembly. However, the instances information of assemblies that were already saved in 
SmarTeam with previous releases is not stored. This functionality provides a tool to save the instances information of 
several CATIA products selected in SmarTeam by the user. The tool may be automated to run on the entire database .

●     Quantity: When the Save process updates the links between each component of the assembly, the activity information 
of each instance is sent to SmarTeam. After that, the Quantity attribute of a component under its parent can be 
computed as the sum of all its active instances. The Quantity attribute value is recomputed and updated in SmarTeam 
each time a SmarTeam/Save or SmarTeam/CheckIn is done on a checked-out/new/released assembly 

●     Drawing Attribute Link: When the user creates a Drawing of a Product, generates balloons and saves the drawing to 
SmarTeam, the CATIA integration creates links of each Part of the Product that is also linked to the Drawing. SDE 
normally uses the balloon feature for drafting interactivity. Therefore. when a SmarTeam Save is performed, many links 
are generated between the actual Part and the Drawing that is saved in SmarTeam. However, according to the SDE 
LifeCycle Rule Setup, when the Part is checked out, the drawing is also Checked Out, which may not be necessary. The 
documentation explains how to avoid saving this link in SmarTeam. 

●     Open for Edit: The Open for Edit check box allows you open a document for editing. When this check box is marked, the 
Check Out or New Release lifecycle operation is invoked and the corresponding lifecycle window appears. After checking 
out/releasing the document, it is opened in CATIA. Note that this check box is only available for Checked In or Released 
documents. If the Check Out/New Release operation fails or is cancelled, the document will not be opened in CATIA.

●      Save /Project Manager: The Project Manager dialog box is displayed for the first new document to save during a CATIA/
SmarTeam Save transaction. 
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SmarTeam CATIA Supply Chain Engineering

●     Reconcile Assembly Structure with a contextual part: The application reconciles single root assemblies. If you need to 
reconcile an assembly containing a contextual part, outside its context, this leads to extending the scope of 
reconciliation analysis out of the current assembly. The context is kept out of the reconciliation scope and the only rule 
available for the contextual part is Reload. A contextual part can be updated (Overwrite rule available) only if it is loaded 
inside its contextual product.

●     Encrypted Passwords for Reconciliator Batches: The new –spwd switch in the CATPDMReconcileSTBatch batch file allows 
the definition of a Secured password for SmarTeam connection. To be able to use this keyword an implementation of 
CATIUExitCrypt must be implemented and declared through the late type CATUExitCrypt.

●     Query to Retrieve Most Recently Available Object from the Database: A new interactive query named “Easy Query” is 
provided to retrieve the most recently available object from the database satisfying the query criterion: “Latest Available 
Revision” is no more a query criteria compare to the “Latest Available Revision” existing query. 
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V4 Integration

New Functionalities

Migrating Draw Data from .Model Files to a Layout

Explains the process of migrating drawing data from .model files to a layout.
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Supply Chain Engineering Exchange

New Functionalities

How ENOVIA information is impacted by Reconciliator
Reconciliation solution enables you to import a set of CATIA documents in ENOVIA, defining how those data issued 
from file will affect data stored in ENOVIA.

Enhanced Functionalities

Mapping Objects using Query
Easy Query enables you to search the objects using default values of Intermediate Query criterion and the 
attribute values which are available in ENOVIA VPM. 
Support of alternate representation functionality enables you to identify the document that is used as an alternate 
shape while executing a criterion search. 

Automating the Valuation of Reconciliation Rules
All objects as Overwrite by Delta enables you to set all mapped objects with no rule to Overwrite by Delta.  
All objects as New Version by Delta enables you to set all mapped objects with no rule to New Version by Delta. 

Selecting the Storage Mode
Reload from VPDM rule is applicable for all other Products inside the same CATProduct.
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2D Layout for 3D Design 

New Functionalities

Callout Creation for Auxiliary and Section Views
Callouts can be created for auxiliary and section views using the contextual menu command Add Callout in Another 
View and when using New View From and New Section/Auxiliary View commands. They have editable attribute 
properties. These callouts can be extracted in the drawing view.

DS ISO 1 Open Type Font
This new font, based on the ISO 3098 standard defining text representation, is delivered along with the application 
to ease the exchange of standardized documents. Four new standards (ISO_DS, ISO_3D_DS, JIS_DS, JIS_3D_DS) 
are available that use DS ISO 1 as the default font.

Export to Layout View without End Points
When exporting a drawing view to a layout sheet, you can now specify whether or not you want to create points at 
the end of geometrical items which do not have any.

Importing DXF/DWG to 2D Layout for 3D Design
You can import DXF/DWG files in 2D layouts.

Migrating Draw Data from .Model Files to a Layout
You can migrate drawing data from .model files to a Layout.

Offset or Aligned Multi-Plane Section Views 
You can now create an offset or aligned multi-plane section view from a multiple segment profile.  
Furthermore, you can create an offset or aligned multi-plane section view from an FTA view or capture. 
You can also learn more about multi-plane section views, their sub-view boundaries and their properties.

Upgrading Geometry in Views
You can now upgrade geometry in views, which will let you benefit from the latest technological enhancements 
brought to sketched geometry in V5.

View Orientation Management
The View Creation dialog box now enables you to define the view orientation when creating auxiliary views, section 
views and section cuts. The orientation of such views can also be changed using the Change View Support dialog 
box.

Enhanced Functionalities

3D Output command enhancements 
You can now launch the 3D Profile and 3D Plane commands when right-clicking 2D geometry in a layout design 
view. 
You can now enter a name for the 3D plane at the time of its creation. 
The 3D Profile command now:
- Lets you output several profiles in one shot. 
- Displays an information message when activating any Automatic Propagation mode while working with a large 
number of elements.

Creating a Line Normal to a Curve
The default command has been changed. You can now select a point on a curve as a start point, and create a 
symmetrical line if needed.

Defining Current Objects
The Define in work object command is now available in the 2D Layout window.

Font Linking Mechanism and True Type Collection Fonts
The support for the font linking mechanism and TrueType Collection fonts is available.

Hide in 3D status in Specification Tree
The status of elements in the specification tree after selecting Hide in 3D option (using Visualization tab in sheet 
and view Properties dialog box) is now identified with a mask on the icon.

Customizing Settings

Tools > Options > Mechanical Design > 2D Layout for 3D Design > View Creation tab > Callout area
The Display "Callout creation" dialog box when running "New View From" command option allows you to display a 
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message box proposing the creation of callouts of section view, section cut and multi-plane section view when 
using the New View From command.

Tools > Options > Mechanical Design > 2D Layout for 3D Design > View Creation tab > Multi-plane Section View 
Boundaries area

The Display all boundaries but extremity ones option allows you to specify whether or not all the boundaries in the 
newly-created multi-plane section views should be displayed by default. On selecting this option, the first and last 
boundary of the first and last sub-view respectively will not be displayed. You can also customize the appearance 
of boundaries.

Tools > Options > Mechanical Design > 2D Layout for 3D Design > Visualization tab > Layout Creation area
The Default render style option allows you to select the render style to be applied by default to the newly-created 
layouts.

Tools > Options > Mechanical Design > Drafting > Administration tab > Drawing management area
The Prevent view geometry upgrade option deactivates the Geometry Upgrade contextual command (used to 
upgrade sketched geometry in views) which is available for layouts, sheets and views.
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3D Functional Tolerancing & Annotation

New Functionalities

Activating and Displaying a View/Annotation Plane
The Display View contextual menu command allows you to display selected view/annotation plane.

Analyzing Display Mode
The Analysis Display Mode option allows you to display and customize the color display for true dimensions, 
dimensions and annotations on deleted geometry, dimensions and annotations on unloaded geometry and invalid 
dimensions and annotations.

Creating an Annotation Set from an Existing One
The new New Annotation Set From... command allows you to create a new annotation set from an existing one in 
another CATPart document with certain rules.

Displaying a Tolerancing Capture
The Display and Set Current Capture command allows you to display the capture and to associate from now new 
created annotations, views, annotation planes with the capture.

Dimensioning Chamfers
The Chamfer Dimension command displayed in the Tolerancing Advisor on selecting a chamfered surface allows 
you to create chamfer dimensions and tolerances.

DS ISO 1 Open Type Font
This font allows you to represent annotations that follow the ISO norms defining text representation (ISO 3098 
norms). Four new standards (ISO_DS, ISO_3D_DS, JIS_DS, JIS_3D_DS) are available that use DS ISO 1 as the 
default font.

Basic Review Capabilities of 3D XML Features Within 3D XML Player and 3D Live
Functional Tolerancing & Annotations features in 3D XML can be reviewed within 3D XML Player and 3D Live 
(without requiring the Live FTA Review license).

Reordering Features in the Specification Tree
Reordering of view/annotation planes, datums, datum targets and tolerancing captures is possible in the 
specification tree.

Tolerancing of User Features

Tolerancing User Features Automatically
The User Feature Tolerance command displayed in the Tolerancing Advisor on selecting an user feature or 
technological result of user feature for which a tolerancing schema has been defined allows you to automatically 
tolerance user features or technological result of user feature.

Tolerancing Schema Catalog
The administrator can define the tolerancing schema catalog for automatic tolerancing of user features or 
technological result of user feature.

User Feature Tolerances Administration Toolbar
This new toolbar is available for tolerancing schema creation.

View Orientation Management

View/Annotation Planes
The new View Creation command for plane creation replaces the previous commands: Front View, Section View 
and Section Cut View.

View Creation dialog box
The View Creation dialog box enables you to create View/Annotation planes. 

Change View Support dialog box
The Change View Support dialog box allows you to change the orientation of views by changing the definition plane 
of a view.

Views/Annotation Planes Toolbar
The new View Creation command for plane creation has been added in this toolbar and replaces the previous 
commands: Front View, Section View and Section Cut View.
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Enhanced Functionalities

All Possible Types Option in Semantic Tolerancing Advisor dialog box
The All Possible Types option in the Semantic Tolerancing Advisor dialog box displays all the possible commands in 
the Commands frame and automatically updates the Geometry feature type list to All possible types option.

Clipping Annotation Plane
The clipping is displayed for Aligned/Offset Section Cut/View when using the Clipping Plane or Select command 
(with the 3D-Annotation-Query Switch On/Switch Off option command active).

Creating an Automatic Default Annotation
The fillet radius criteria can now be taken into account in the fillet faces selection.

Creating Framed Basic Dimensions
A localization geometrical tolerance without datum reference frame and applied to a circular or rectangular pattern 
of constructed geometries for thread representations, can now be taken into account for automatic creation of 
framed/basic dimensions.
Font Linking Mechanism and True Type Collection Fonts
The support for the font linking mechanism and TrueType Collection fonts is available.

Managing 3D Annotations in Result Annotation Set
The contextual menu command Delete_Result_Feature allows the individual deletion of features in the Result 
Annotation Set.

Managing Hide/Show in Captures
The Show/Hide status of external part instances whose geometries are referenced by annotations in the Assembly 
Annotation Set can be managed in capture.

Mirroring Annotations
The mirroring of annotations can be controlled using the Mirror annotations option.

Propagating Geometry Selection for Feature Creation
The All same diameter, same pitch, parallel CG thread Cylinders option allows you to propagate the selection to the 
threads in the 3D part with the same diameter and pitch, and parallel axis with the selected Constructed Geometry 
Thread.

Text, Flag Note and Note Object Attribute Creation
Text, Flag Note and Note Object Attribute can be created on PartBody and Body features, some Part Design 
features, Axis systems, User Features and Technological Result features of Part Design Hole feature and User 
Features.

Using the Scope Range
The contextual menu command Geometry Connection Management allows you to see the last geometrical element 
to which the annotation was linked to in case of broken links.

Creating an Automatic Constructed Geometry

Constructed Geometry Circle
A constructed geometry circle can be created from cone-plane, cone-cylinder or cone-cone intersection. 

Highlighting Represented Geometry for Constructed Geometry
Selecting a constructed geometry (generated automatically or managed manually) highlights the represented 
geometry.

Introducing the Tolerancing Advisor

Annotations Attached to First Selected Feature
The dimension or annotation created using propagation commands is attached to the first selected geometrical 
feature.

Runout Tolerances in Revolute Surface
The following commands are available for single and multiple revolute surface selection: Circular Runout 
Specification and Total Runout Specification. 

Managing 3D Annotations in 3D XML Files

Support of Aligned/Offset Section Cut/View 3D Clipping
The 3D clipping is displayed on selecting the Aligned/Offset Section Cut/View in the specification tree or geometry. 
It is also displayed when selecting a capture that has a component of Aligned/Offset Section Cut/View.

Support of Text, Flag Note and Note Object Attribute
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The geometrical element is highlighted when Text, Flag Note or Note Object Attribute is selected and vice-versa.
Support of Show/Hide of Part Bodies and Geometrical Sets When Displaying Capture

The Show/Hide status of part bodies and geometrical sets is respected when displaying a capture.
Support of Tolerance Schema Applied to User Features

The geometric features, dimensions, tolerances and annotations that are linked to the tolerancing schema are 
highlighted when the Nx text is highlighted.

Customizing Settings

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Dimension tab > Analysis Display Mode area
The Activate analysis display mode option allows you to customize 3D annotations using different colors according 
to their types and status.

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Display tab > Capture display area
The Mirror annotations option defines whether the annotations are automatically mirrored when displaying a 
capture.

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Tolerances tab > Chamfer Size area
This option defines the tolerance options for chamfer size. 
Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > View/Annotation Plane tab > 
Dimension And Annotation Default Position Along Normal View area
The Try to create in the annotation plane (Z=0) option defines whether the application always tries to create 
dimension or annotation in the plane of the current annotation plane when its definition allows to do it. Thus this 
option defines the dimension and annotation position at creation.

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Tolerances tab > New Size Tolerances 
Creation area

The Propose the last created tolerance values option defines whether the last tolerance type and values defined in 
a command should be proposed as default for the next command.

Tool > Options > Mechanical Design > Functional Tolerancing & Annotation > Tolerancing tab > User Features Tolerancing 
Schemas Catalog area

This option allows you to define the path to the tolerancing schema catalog that is to be used for automatic 
tolerancing of user feature or technological result of user feature.
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Aerospace Sheetmetal Design

Enhanced Functionality

Positioning Joggle Plane
A new Position option is added in the Joggles tab of the Sheet Metal Parameters dialog box for positioning joggle 
plane.
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Cast and Forged Part Optimizer

Enhanced Functionality

Analyzing Wall Thickness
You can now perform a Section cut through a new Sections tab added in the Wall Thickness Analysis dialog box. 
A new Include Thread/Tap analysis option added in the Inputs tab lets you integrate the threads or taps in the 
analysis.
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Composites Design

New Functionalities

Grid Approach
A new process is implemented with a set of new commands. This process enables a better link between stress 
analysis and composite design by taking into consideration structural elements (such as stiffeners, strings, frames, 
etc…) during composite design. 

Solid Approach
Lets you create plies by slicing a solid.

Junction Lines Assistant 
Add material to ply

Adds material to plies, to solve manufacturing constraints.
Merge Stackings

Allows you to take composites information from one stacking from another part in the assembly and to transfer all 
of them to the current part.

Enhanced Functionalities

Manufacturing Part 
It can be created As Result, increasing performances and reducing the size of the data. 

Skin Swapping 
A new option Wrap Curve lets you transfer plies contours using a deformation based on wrapping curves. 
A new option Unfold provides a complete flatten view of the Composite plies. 

3D Multisplice
A new option Curve Selection from 2D allows the  selection of curve/lines in flattened view of ply to splice it.
A new Repeat option restarts staggering step after n steps (n is specified by the user). 
Filtering can be done through material or through orientation filter.
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Core & Cavity Design

New Functionalities

Face Color Editor
Changes the color of faces.

Middle Point
Lets you create the middle point of a curve.

Wall Thickness Analysis
Measure the thickness of a part.

Enhanced Functionalities

Main Pulling Direction and Slider Lifter Pulling Direction 
Quick dispatch functionalities are now available. 
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Functional Molded Part

New Functionalities

Dynamic Sectioning
This new functionality allows you to visualize 3D section view of a part at a position specified by section plane. You 
can choose the position to cut by moving section plane.

Creating Thickness
This new functionality lets you add thickness to the faces of a part.

Creating a Flange
The flange is previewed with the given values only if you click Preview button while creating it.

Modifying Features Using Local Work
This new functionality allows you to work locally on the functional feature(s).

Creating Functional Edge Fillets
This new functionality allows you to fillet the edges at the intersection of the functional features.

Creating Intersection Fillet
You can apply relevant intersection fillets (with Core, Cavity or Core/Cavity) for the Added, Shellable, Internal, 
External, Core, Cutout, Push, Pull, Pocket, Boss, Rib, Rest, Grill and Reinforcement features in the Fillet tab.          

Visualizing and Selecting Protected, Internal and Core Features
This new functionality provides you better visualization and selection options while working on a part containing 
protected, internal and core features.

Enhanced Functionality

Analyzing Wall Thickness
You can now perform a Section cut through a new Sections tab added in the Wall Thickness Analysis dialog box. 
A new Include Thread/Tap analysis option added in the Inputs tab lets you integrate the threads or taps in the 
analysis.
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Generative Sheetmetal Design

Enhanced Functionalities

Selecting the Multiple Edges
You can manually select several edges to create walls in a single operation using the Wall On Edge command.

Creating a Bead
You can create a bead with a fillet on a profile whose edges intersect.

Creating a Flange
You can now specify the orientation plane when creating a flange.

Creating Bends from a Line
A new BTL Support option is available when creating bends from a line.

Recognizing Chamfers
The chamfers are automatically recognized when you use the Recognize command.

Recognizing Conical Bends
The conical bends are automatically recognized when you use the Recognize command.

Creating a Cutout 
A new Both option enables to create only one cutout that cuts the bottom skin and the top skin of the sheetmetal 
part at the same time.

More about Creating a Cutout 
You can now create a new kind of pocket cutout that impacts one or multi-planar faces and cylindrical bends.

User-Defined Stamping Feature
The Punch and Punch and Die modes are available for creating user-defined stamping features. The User-Defined 
Stamp Definition dialog box is updated with Definition Type, Fillet and Position on wall frames.

Bends Representation
The graphical representation of a complex bend impacted by the stamp has been improved during folding/
unfolding operation.
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Generative Drafting

Enhanced Functionalities

Associative Graphical Dress-Up Features
The graphical properties of drawings extracted from CATProcess in DELMIA products are retained during view 
modification or update.

Detail Circular View Arrows
The orientation of detail circular view arrows is compliant with the international standards for detail view/profile 
and quick detail view/profile.

Generating an Advanced Bill of Material
The part/product properties defined in Properties dialog box using Define other properties... option can be 
customized in the Bill of Material.

Offset Constraint
The section profile can be created using the Offset constraint in Tools Palette, which keeps the profile associative to 
the geometry in offset section view/cut and aligned section view/cut.

Persistency of Generative View Style During Update
The generative view style applied to a view is retained during view update. To remove the generative view style 
applied to the view, a new command button Remove style has been added to view Properties dialog box.

View Callout Styles
The callout styles for projection and section view callouts has been modified.

Projection of 3D Geometry in Approximate Mode

Persistency of Graphical Dress-up
The persistency of graphical dress-up is available in Approximate views.

Projection of 3D geometry in Approximate Mode
The 3D wireframe geometry can be projected in Approximate views.

Creating and Modifying Views from a .model
The 3D wireframe geometry in .model documents can be projected in Exact And Approximate modes.

Customizing Settings

Tools > Options > Mechanical Design > Drafting > View tab > View generation area 
The Approximate/Raster/CGR views update status setting allows you to choose the up-to-date status computation 
mode depending on the type of data for Approximate/Raster/CGR views.
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Healing Assistant

New functionalities

Compare & Review
Reviews the comparison of two geometrical models.
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Interactive Drafting

New Functionalities

DS ISO 1 Open Type Font
This new font, based on the ISO 3098 standard defining text representation, is delivered along with the application 
to ease the exchange of standardized documents. Four new standards (ISO_DS, ISO_3D_DS, JIS_DS, JIS_3D_DS) 
are available that use DS ISO 1 as the default font.

Upgrading Geometry in Views
You can now upgrade geometry in views, which will let you benefit from the latest technological enhancements 
brought to sketched geometry in V5.

Enhanced Functionalities

Creating a Line Normal to a Curve 
The default command has been changed. You can now select a point on a curve as a start point, and create a 
symmetrical line if needed.

Font Linking Mechanism and True Type Collection Fonts
The support for the font linking mechanism and TrueType Collection fonts is available.

Customizing Settings

Tools > Options > Mechanical Design > Drafting > Administration tab > Prevent view geometry upgrade
This option deactivates the Geometry Upgrade contextual command (used to upgrade sketched geometry in views) 
which is available for drawings, sheets and views.
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Mold Tooling Design

Enhanced Functionalities

Adding or Replacing a component
The option Keep As Reference lets you decide to duplicate or not the model reference.

Display Technological Results
The display has been enhanced (units taken from the Tools > Options, choice of the axis system, sorting 
capabilities, display of the hole origin and axis, ...)

Components catalogs have been updated.

New Functionalities

Tooling to Drawing 
Creates a table containing technological results of all drilling holes in the Drafting workbench. 
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Part Design

New Functionality

Dynamic Sectioning
This capability allows you to visualize 3D section view of a part at a position specified by section plane. You can 
choose the position to cut by moving section plane.

Enhanced Functionalities

Creating Threaded Holes
While selecting a standard thread type, if the diameter of a hole set by you is matching with the thread standards, 
the related thread description automatically gets selected as per the thread standards.  
If the diameter of a hole set by you does not exist in the standard file while selecting a standard thread type, a 
warning message is displayed. In this case, the diameter is set to the first value in the standard file.

Creating Edge Fillets
A new Intersection with selected features selection mode is available for filleting edges.

Creating Edge Fillets / Creating Variable Radius Fillets / Creating Chordal Fillets
In Tangency mode, the tangent continuous edges of the selected edge are now managed to ensure a better fillet 
stability and robustness. The productivity is improved as more fillets are automatically rerouted in case of design 
changes. 
The variable fillet radius is displayed at the end of the propagation of the selected edge.

Reshaping Corners
The setback distance value can exceed the length of the corresponding concurrent edges.

Reordering Features
You can now move features from one branch to another and from an ordered root to a non-ordered root.

Customizing

Part Document
You can now choose to import colors on features created through the Copy Paste As Result or Copy Paste As Result 
with Link options.
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Sketcher

Enhanced Functionality

Creating a Line Normal to a Curve
This capability allows you to avoid position or shape modification of a geometry when creating a line normal to a 
curve.
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Structure Design

New Functionalities

Importing and Exporting SDNF files
SDNF is a neutral file format which supports the exchange of a steel structure design between two applications. 
Using SDNF Translator, a steel structure data can be exchanged between two applications.

Enhanced Functionalities

Extrapolating in Piece Part Generation
In Piece part Generation command, the Extrapolating Offset can be specified as per the manufacturing 
requirements.

Extrapolating in Coping
Coping Strategy, Coping Subtype and Extrapolation Offset values can be set in Coping command. Values set in 
Coping command will override values set during Piece Part Generation command.
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Wireframe and Surface

New Functionality

Creating Dynamic Section View 
This capability allows you to visualize 3D section view of a part at a position specified by section plane. You can 
choose the position to cut by moving section plane. 

Enhanced Functionalities

Creating Points
A new Distance along direction option is available when creating a point on a curve.

Creating Multiple Points and Planes 
You can now choose the repetition mode between Absolute and Relative.

Creating Extruded Surfaces
A new Mirrored Extent option enables to create a mirrored surface. 

Creating Cylindrical Surfaces
A new Mirrored Extent option enables to create a mirrored surface. 

Isolating Geometric Elements
You can now isolate all GSD features.

Managing the Background Visualization 
You can select an annotation text that will be used to determine a plane.

Analyzing Using Parameterization 
A new filter is available called All Axis Systems.

Repeating Objects 
You can now choose the repetition mode between Absolute and Relative. 
You can now activate both Repeat and Datum modes at the same time.

Selecting Using Multi-Output
All common inputs are now directly aggregated under the Multi Output feature.

Instantiating Power Copies
Multi-Selection is now available prior to entering the command.
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Digitized Shape Editor

New Functionalities

Working with Drafting
You can now generate drafting views and section cuts of meshes in exact mode.

Clouds/Points 
Creates cloud of points from CATIA points and CATIA points from clouds of points. 

Enhanced Functionalities

Export
You can define your own export format.

Import
GoCad (surfaces) and SRTM formats are now supported. 

Discretize Curves
The output is a V5 feature.

Activate, Remove, Split
The Flood selection mode has been enhanced with an angle criterion.

Curve Projection 
You can create the output as Nearest or not. 
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FreeStyle Shaper, Optimizer & Profiler

New Functionality

Performing a Mirror Analysis
The Mirror Analysis command allows you to mirror elements and some analysis.

Enhanced Functionalities

Compass Management Tools
Three new commands have been added to Quick Compass Orientation toolbar. You can create a new axis system, 
set the compass to mean plane or trace plane. 

Analysis Enhancements

Connect Checker
The parent matching constraint node and individual matching constraints can be selected for connection analysis in 
the Connect Checker command.

Displaying and Modifying Dress-Up Features
The geometric set or valid elements under it can be given as input elements for dress-up features.

Mapping Analysis with Materials Mode ON
The materials mode is automatically set to ON during mapping analysis if the No warning message if material 
mode is not ON option is selected. This is applicable to: Draft Analysis, Environment Mapping, Isophotes Mapping 
Analysis and Surface Curvature Analysis.

Performing a Surface Curvature Analysis
A new analyses type option Mean has been added in the Surfacic curvature dialog box. With the Mean option the 
computed curvature is equal to (Minimum curvature + Maximum curvature) / 2.

Using Dynamic Cutting Planes
The geometric set or valid elements under it can be given as input elements. Two new options On Point and On 
Value have been added in Cutting Plane Analysis dialog box.

Creating a Styling Fillet

Approximation tab
The Advanced tab has been renamed as Approximation tab.

Fillet Type
The Fillet Type option added to Styling Fillet dialog box allows you to switch to edge fillet mode. 

Logical Join
The Logical Join option allows you to use the Logical Join tolerance in case the factory resolution is too restrictive.

Multiple Fillet Result Management
The multiple fillet result management allows you to keep either one or all sub-elements created. 

Output Results
The Output Results area gives you geometric information about the fillet during creation.

Variable Fillet
The Variable Fillet option is available even if a common edge does not exist.

Shape Modification Enhancements 

Breaking Curves and Surfaces
The following new enhancements has been done in Break command: element selection, trap selection, create point 
and create isoparameter and create join. 

Breaking Surfaces
Two new options have been added in Break dialog box, Extrapolation area: IsoU Extrapolation and IsoV 
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Extrapolation.
Creating a Matching Constraint

The following new options have been added to Match Constraint dialog box: On basic geometry, locking options 
and support options. 

Styling Extrapolate
A new option Up To has been added in Limit Type list. This option allows you to select a limiting element for 
extrapolation of surfaces and curves.

Customizing Settings 

Tools > Options > Shape > FreeStyle > General tab, Mapping Analysis option area
The No warning message if material mode is not ON option allows you to set the material mode automatically to 
ON during the isophotes mapping analysis even though the Materials option in the View > Render Style > 
Customize View command is cleared.

Tools > Options > Shape > FreeStyle > General tab, Mirror Analysis option area
The Feedback color allows you to select the default color in which the mirrored elements and analysis are displayed 
when Display mirror tags option is active in the Mirror Analysis dialog box.

Tools > Options > Shape > FreeStyle > General tab, Selection options area
The Filter options : deselect all points option automatically deselects all the selected control points of the selected 
elements when the Filters mode is changed in the Control Points dialog box.
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Generative Shape Design, Optimizer, Developed 
Shapes & BiW Templates 

New Functionality

Creating Dynamic Section View 
This capability allows you to visualize 3D section view of a part at a position specified by section plane. You can 
choose the position to cut by moving section plane.

Enhanced Functionalities

Creating Points
A new Distance along direction option is available when creating a point on a curve.

Creating Multiple Points and Planes 
You can now choose the repetition mode between Absolute and Relative. 

Creating Parallel Curves
You can now use Laws with two parameters (Linear or S type) when creating several curves.

Creating Conic Curves 
The Default Parabolic Result check box lets you create a parabolic conic curve. 

Creating Extruded Surfaces
A new Mirrored Extent option enables to create a mirrored surface. 

Creating Cylindrical Surfaces
A new Mirrored Extent option enables to create a mirrored surface. 

Creating Offset Surfaces
The accuracy of error diagnosis has been increased. For temporary analysis, Surfacic Curvature Analysis can be 
used.

Creating Edge Fillets / Creating Variable Radius Fillets / Creating Chordal Fillets
In Tangency mode, the tangent continuous edges of the selected edge are now managed to ensure a better fillet 
stability and robustness. The productivity is improved as more fillets are automatically rerouted in case of design 
changes. 
The variable fillet radius is displayed at the end of the propagation of the selected edge.

Reshaping Corners
The setback distance value can exceed the length of the corresponding concurrent edges.

Isolating Geometric Elements
You can now isolate all GSD features. 

Managing the Background Visualization 
You can select an annotation text that will be used to determine a plane.

Analyzing Using Parameterization 
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A new filter is available called All Axis Systems.

Repeating Objects
You can now choose the repetition mode between Absolute and Relative. 
You can now activate both Repeat and Datum modes at the same time.

Selecting Using Multi-Output
All common inputs are now directly aggregated under the Multi Output feature.

Instantiating Power Copies
Multi-Selection is now available prior to entering the command.

Creating Extruded Volumes 
A new Mirrored Extent option enables to create a mirrored volume.
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Imagine & Shape

New Functionalities

Creating Subdivision Instances
The IMA - Instantiate contextual menu command allows you to create multiple instances of a subdivision surface.

Drafting a Subdivision Surface
The Draft of subdivision capability allows you to define a draft angle on a subdivision surface.

Creating a Net Surface
The Net Surface capability allows you to create a subdivision surface based on an existing set of curves.

Cutting a Subdivision Surface by a Plane
The Cut by Plane capability allows you to cut a subdivision surface by a plane.

Enhanced Functionalities

Cutting Faces
A new Cut Manipulation option lets you position the sections. 

Aligning Vertices
Two new options have been added: Orthogonal, to define the direction of projection normal to the selected support 
surface and Along Direction to define the direction of projection along a defined direction to the support surface

Creating a Surface Using Revolve
You can now manipulate and align points and edges using a manipulator when creating a revolution surface.

Creating a Surface Using Extrude
You can now manipulate and align points and edges using a manipulator when creating a extruded surface.
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Quick Surface Reconstruction

New Functionalities

Geometric Tolerancing Checker 
Checks Geometric Dimensioning and Tolerancing elements on a mesh resulting from a digitization. 

Working with Drafting
You can now generate drafting views and section cuts of meshes in exact mode.

Enhanced Functionalities

Automatic Surface
The output is a feature.

Activate
The Flood selection mode has been enhanced with an angle criterion.

Curve Projection 
You can create the output as Nearest or not. 

Activate
The Flood selection mode has been enhanced with an angle criterion. 

PowerFit 
The dialog box has been redistributed into three tabs. 
Area selection is available from the dialog box. 
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Shape Sculptor

New Functionalities

Mesh Intersection
Performs intersections on several meshes.

Highlights 
This command is replaced by the Isophotes Mapping Analysis command.

Working with Drafting
You can now generate drafting views and section cuts of meshes in exact mode.

Enhanced Functionalities

Export
You can define your own export format.

Import
GoCad (surfaces) and SRTM formats are now supported. 

Boolean Operations
A contextual menu lets you create a mesh without exiting the command.

Mesh Morphing 
The output is now a feature.  
Two options have been added to improve the morphing: Insert Target and Insert Limit
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Advanced Meshing Tools

New Functionalities

Rule Based Surface Meshing

Rule Based Surface Mesher
The new Rule Based Meshing (RBM) product allows you to create a surface mesh based on parameters and rules 
that are stored and saved in a mesh rule file.

Enhanced Functionalities

Surface Meshing

Projecting External Curves in the Surface Mesher and Adding/Removing Constraints (Specifications) in the Advanced 
Surface Mesher

If the projected curve encounter boundary edges (for example, the edge of a hole), the projected curve is going 
through the boundary edges.

Customizing Settings

General
Automatic naming of mesh parts enhanced to include the mesh part support, part name, and (for analysis on a 
product) the part instance number.
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Generative Structural Analysis

Enhanced Functionalities

Result Computation

Computing using the AnalysisUpdatePLMBatch
A new batch is available for computing a .CATAnalysis document stored in a database, and saved it in a database.

Result Visualization

Animating Images
If you animate the colors of an image with a full cycle animation or if you animate the colors of an image that 
contains complex values, the color map of the image becomes symmetrical.

Editing Images
You can activate images that are not in the current analysis case using the Force Activate contextual menu. This 
command is useful to compare images from different analysis cases using the post-processing capabilities such as 
animation, cut plane analysis, information, etc. 
The Complex options have been modified: you can now visualize complex values at a given phase.

Customizing Settings

General
Automatic naming of mesh parts enhanced to include the mesh part support, part name, and (for analysis on a 
product) the part instance number.
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Nonlinear Structural Analysis and Thermal Analysis 

Enhanced Functionalities

Controlling Parallel Execution
Parallel processing is now supported. You can now specify the use of two CPUs for jobs run from the Nonlinear 
Structural Analysis or Thermal Analysis workbenches.

Querying Values for a Results image
You can now query, or “probe,” nodes and elements in your model or in a results image to obtain information 
about your model or analysis. Thus, you can collect nodes and elements of interest, examine them, and export 
them to a text file or to a Microsoft Excel spreadsheet.

Creating a Display Group
You can now reframe the window around the contents of a particular display group using the Reframe On option 
available in the contextual menu and the Create Display Group dialog box. 

Improved Usability for Creating, Customizing, and Deleting Analysis Jobs
You can now create and customize analysis jobs directly from the Job Monitor as well as delete analysis jobs 
directly from the specification tree.

Inserting a New Step Between Two Steps in a Structural analysis case or in a Thermal Analysis case.
You can now insert a new step between two existing steps in your Simulation History by using the new Insert Step 
Below option.

Data Mapping Options
You can now import temperature data, pressure data, or heat flux data from a Microsoft Excel spreadsheet (.xls*) 
or a text file (.txt) into an analysis.

Using Local Coordinate Systems 
You can now specify that the local coordinates created in the Part Design workbench be transformed in the 
Nonlinear Structural Analysis workbench for use as cylindrical or spherical coordinates.

Importing Restraints
You can now import a restraint feature or a restraint set from the Generative Part Structural Analysis workbench 
into an analysis. The Imported Restraint capability supports import of clamp, surface slider, ball joint, slider, pivot, 
sliding pivot, user-defined restraints, and iso-static restraints.

Importing Loads
You can now import a load feature or a load set from the Generative Part Structural Analysis workbench into an 
analysis. The Imported Load capability supports import of pressure, distributed force, moment, bearing load, 
imported force, imported moment, acceleration, rotational force, line force density, surface force density, volume 
force density, and force density.

Using Analysis Sensors in an Optimization Problem
You can now use the Product Engineering Optimizer (PEO) workbench with Nonlinear Structural Analysis and 
Thermal Analysis to optimize a desired analysis result.

Creating a Solution Sensor
You can now create global solution sensors in Nonlinear Structural Analysis and Thermal Analysis. Global sensors 
are useful for creating parameters in Knowledgeware formulas and for driving optimizations with Product 
Engineering Optimizer (PEO). 

Point Loads, Distributed Loads, and Load Densities
Two new load types, distributed loads and load densities, are now available; and the existing point load function 
has been enhanced (new Force Norm and Moment Norm fields).
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Electrical Harness Flattening

Enhanced Functionality

Synchronization of knowledge parameters on bundle segment
The knowledge parameters on the bundle segment can now be extracted and synchronized.
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Electrical Harness Installation

New Functionality

Routing Branches on Floating Point
You can update the position of a 3D Point to which two (or more) branches are routed. The updated position is its 
natural position regarding the two branches. 

Enhanced Functionalities

Placing Devices from External Data 
In the External Device List window, you can now sort Electrical devices by column selection or filter on character 
string. 

Migrating Step by Step...
The arrangement of several bundle segments arranged across the support section in V4 will be maintained in V5 as 
well during the migration. 

Computing Bundle Segments Using the FLEX Algorithm
A branch created with a particular Segment Computation setting will have its electrical curve updated with the 
same algorithm throughout its lifecycle. Switching from one algorithm setting to another has no impact on the 
geometry of the existing electrical curves. The change in algotype can be done by Recompute All Bundle Segments 
command.

Adding a Support 
A Preview option enables you to preview the change in the shape of bundle segment before finalizing the position 
of support on bundle segment. 

Customizing Settings

Bend Radius Ratio
A new option Keep ratio, if creation mode is Bend Radius Ratio  enables to maintain bend radius ratio of the 
branchable during Wire Routing. The new attributes for branchable will enable you to maintain the bend radius 
ratio. 

Visualization for Local Slack 
The option Display Slack for all Bundles enables you to visualize all the slacks added in the entire harness, at all 
the portions of branches, in design mode in the session, when the command Local Slack is activated. 
The option Specific Symbol for Points when adding Local Slack enables you to select particular color and symbol for 
points when adding Local Slack on the branches.
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Ship Structure Detail Design

Enhanced Functionalities

Previewing Small Assemblies
Manipulator or Switch Side button can be used to change the orientation of small assemblies. Preview of actual 
Small Assembly can be seen by using Preview button.

Representing Slot in Drafting
In drafting Slot location can be identified by the cross mark. The number placed next to the cross mark indicated 
the type of Slot.

Modifying Trace offset
Trace offset value once specified can be reused as default for subsequent Stiffener on Free Edge definition.

Modifying Anchor Point Offset
In Face Plate command, the anchor point offset value once specified can be reused as default for subsequent Face 
Plate definitions.
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Structure Functional Design

Enhanced Functionalities

Previewing Small Assemblies
Manipulator or Switch Side button can be used to change the orientation of small assemblies. Preview of actual 
Small Assembly can be seen by using Preview button.

Representing Slot in Drafting
In drafting Slot location can be identified by the cross mark. The number placed next to the cross mark indicated 
the type of Slot.

Modifying Trace offset
Trace offset value once specified can be reused as default for subsequent Stiffener on Free Edge definition.

Modifying Anchor Point Offset
In Face Plate command, the anchor point offset value once specified can be reused as default for subsequent Face 
Plate definitions.
 

Generating Finite Element Models
In Create Mesh command, mesh parameters can be precisely controlled to generate accurate mesh.
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3-Axis Surface Machining

New Functionalities

Advanced Finishing
Dedicated to the one-shot machining of grooves.

Enhanced Functionalities

Machining/Slope areas
You can add user subsets for horizontal and intermediate areas.

Contour-driven operations
Parallel contour guiding strategy manages inner island through manual selection or automatic detection. 
Parallel contour guiding strategy proposes to take the check into account when selecting the guide via Select faces. 
Some parameters have been moved from the Radial to the Strategy tab. 
A Tool Axis Motion NC macro is now available for Approach and Retract.

4-Axis Curve Sweeping
Parameter Max discretization step has been added to improve the quality of the tool path.

Sweeping
A Tool Axis Motion NC macro is now available for Approach and Retract.

Spiral Milling
A Tool Axis Motion NC macro is now available for Approach and Retract. 
Start points can be defined.

Pencil
A Tool Axis Motion NC macro is now available for Approach and Retract.

Collision checking
User representations can be used in collision checking.

Probing operations
NC_CYCLE_OFF has been enhanced.
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Advanced Machining

Enhanced Functionalities

Enhancements brought to multi-axis machining operations

Refer to Multi-Axis Machining for more information.
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DPM Process and Resource Definition

New Functionality

PRD

DPM Process and Resource Definition
You can now add or delete non-default columns to a Gantt Chart 

Users can add columns to the Gantt chart that contain attributes that are in the properties of the activity or 
resource.  The attributes can be user-created attributes, created in Knowledgeware.  In addition, the calculation of 
the process duration is now calculated using the scientific calculation time analysis.  The parameters used in these 
calculations' formulae are available for viewing in the Gantt chart. 

Replace the top node of a product 
You can now replace the top node of a product while keeping track of the links within the process. 

Search the Gantt charts 
The Gantt chart now offers a search mechanism that is available in all Gantt charts. 

Manufacturing Hub
Validation Pattern for Property Pages 

You can validate inputs for attribute values in the Property page using Validation Pattern. 
Load Context 

You can load context (Manufacturing, Volumetric, and User) computed by Context Solver Batch.  
Product/Resource Tree Display Order 

This functionality allows the DPM product/resource tree to be ordered in the same manner as the DELMIA Process 
Engineer product/resource tree. 

Enhanced Functionalities

DPM Process and Resource Definition
Tooltips have been added to control flows in the PERT Chart and related viewers 

If two activities are linked, the tooltip displays that information.  When a switch activity is linked, the output 
number also appears in the tooltip.  The tooltips also show precedent constraints. 

Resources selected in the Gantt chart are cross highlighted in the PPR tree and in the geometry 
Conversely, selecting resources in the tree or geometry cross highlights in the Gantt chart. If an object is not 
visible in the PPR tree because the tree is collapsed, the parent node is highlighted. 

Uneditable cells in the Gantt chart are marked in gray 
This clarifies for the users which cells may be modified and which cannot. 

Process Verification has a Show Current Activity's Products 
This option enables you to see only those products associated with the current activity. This option is also available 
for TSAs in the Process Verification Across Resources dialog box. 

Process Verification enables you to hide all unassigned resources 
This option is also available in the Process Verification Across Resources dialog box. 

Process Verification enables you to select which activity you want to see after a switch activity 
This option is also available in the Process Verification Across Resources dialog box. 

Customizing Settings

DPM Process and Resource Definition
New display options for the Gantt Chart 

The display options for the Gantt chart have been re-organized. In determining whether you want to see specified 
or calculated times, you can now differentiate between how you want the time displayed for the parent and leaf 
node.  In addition, you can select your own colors for specified and calculated times. You also no longer must have 
your Gantt chart left-aligned; you can choose to have data centered within a column or right-aligned. 

Moved options 
The Consider Product Flow option has been moved from the Gantt Chart tab to the DPM > Manufacturing System 
Definition > General tab because that option only applies to the Manufacturing System Definition. For the user's 
convenience, the Display Activity Relations options are available from the context menu on the Gantt chart and are 
no longer part of the customizing settings. 
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Verification has added Navigation options 
You can choose to retain or ignore the effect of a Hide/Show command on the visibility of a product or resource 
during process verification. Also, you can choose whether to see the first or last child process when navigating 
down. This option applies to both the Process Verification and Process Verification Across Resources commands. 

Manufacturing Hub

DPM Process and Resource Definition
Server Computed Context Options 

This option controls the load of a pre-computed context. 
Load 3D States and Positions 

This option is enhanced to load all 3D states and positions defined on upper level parent products and resources. 
PackNGO 

You can specify the pre-defined directory path for storing the pack and go data set. 
ProductList/ResourceList Display Order 

A new option Manufacturing Hub Order is added to ProductList/ResourceList Display Order. 
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Lathe Machining

Enhanced Functionalities
Maximum Spindle Speed at Operation Level 

This functionality enables to define the Maximum spindle speed at machining operation level (by default, 
the value is the Maximum spindle speed set on the Part Operation). This setting is available for all turning 
and axial machining operations. 

Local Offsets to the Part Profile in Rough Turning Operation 
This enhancement provides the Local Information functionality in the Rough Turning operation. In addition 
to the global offsets that can be assigned to the part profile, you can also add local offset values. 

Angular Units (length per revolution) for Air Cutting Feedrate 
In addition to Linear units (length per minute), Air Cutting feedrate can now be specified in Angular units 
(length per revolution). 

End Limit Option for Grooving Turning 
This functionality helps to define the end limit on the profile geometry of single flank groove turning 
operation and also provide an option for specifying end limit offset value. This helps to control the tool 
path on the open end of groove turning operation.

Product Enhancement Overview Version 5 Release 20



Multi-Axis Surface Machining

Enhanced Functionalities

Spiral Milling
Start points can be defined.

Collision checking
User representations can be used in collision checking.
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Multi-Pocket Machining

Enhanced Functionalities

Multi-Pockets Flank Contouring
Two tool axis guidance strategies are available.

Collision checking
User representations can be used in collision checking.
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Multi-Slide Lathe Machining

Enhanced Functionalities
Toolpath Points Based on Turret 

A new Toolpath points based on the turret involved in the Manufacturing Program option is provided in the Part 
Operation editor. This option enables you to output the toolpath points based on the turret axis system for turning 
operations. 

Tool Compensation Output for B-axis and C-axis 
A new Tool Path with B and C-axis option is provided in the Part Operation editor. When this option is selected, the 
generated tool path takes into account the defined B-axis angle and C-axis option. 
Compensation points other than P9 are rotated about P9 by an amount specified as the B-axis angle and will 
become a mirror image point about the turret axis in case of a tool axis flip (C-axis). 
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NC Machine Tool Builder Machining

Defining Machines with Interchangeable Heads 
Previously, the creation of Milling Machines and Milling Heads, with the capability to do a head change during 
simulation, was not supported. This functionality enables to create such machines to be used in simulation. It 
allows to create a new Milling Machine Head, which can then be inserted into the milling machine CATProduct. 

Defining Tool and Work-piece Mount Points 
This section describes how to create, modify and delete multiple tool and work-piece mount points on milling 
machines, using the Create Mount Point command. 
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NC Machine Tool Simulation Machining

New Functionalities

Display of Stock Color during Simulation 
This functionality enable you to visualize the tool colors on the stock during material removal with machine 
simulation. The material removed is displayed in the color of the tool and helps to visualize the stock effectively. 

Machine Instruction Support for Interchangeable Milling Heads 
For Mill-Turn Simulation, you can define Machine Instruction activities on Interchangeable milling heads. 

Customizing Settings

Integrated Material Removal 
A new option Display Tool Color on Stock is added. You can enable tool colors on the stock during material removal 
with machine simulation. 
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NC Manufacturing Infrastructure

Enhanced Functionalities

Tool Query without Tool Type 
This enhancement allows you to make a Tool Query without specifying a tool type. 

Reverse Machining Consistency 
This enhancement extends the support of Reverse Machining Conditions to all relevant Machining Operations. In 
addition, there will be an indication to identify Reversed Machining Operations in the MO name. 
If any of the selected operations are locked, you will be notified about this and there will be an option to unlock 
these operations and to apply Reverse Machining Conditions. 

Machining Directions at Machining Process Instantiation 
With this enhancement, you can instantiate a machining process by taking into account either the absolute or 
current axis system assigned to a machining axis system change for the machining direction. 

Auto-sequence Improvements 
This enhancement reduces the time required to sequence operations for any rules and provides an new option for 
sequencing with a minimum number of tool changes. 

Collision checking 
User representations can be used in collision checking. 

Customizing

Reverse Machining 
The name of MO gets appended with the Reverse Keyword. 

During NC Code Generation 
No generation of NC code if MO is not updated. 

MP Instantiation 
When a machining process is instantiated, the tool axes and machining directions of the activities in the MP keep 
their absolute positions. 
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Prismatic Machining

New Functionalities
New Trochoid Milling Operation 

A new milling operation dedicated to hard-material machining is provided. The trochoidal motion ensures a 
constant material removal which increases the tool life duration. 

Pocketing Operation 
This highlight provides capability to machine pocket areas without jump motion on check elements. 

Bottom Plane Definition Using a Point 
This highlight allows you to specify the bottom plane using a point for Pocketing, Profile Contouring, Groove Milling, 
and Facing operations. When you do not have a floor to define for a profile, you can select a point as the bottom 
and normal of the bottom would be taken from the tool axis. Any change in the tool axis would effectively change 
the direction of bottom (always keeping it perpendicular to the tool axis and passing through the selected point). 

Enhanced Functionalities
Extended Multi-edit Support 

Multi-edition allows you to modify the common parameters of several Machining Operations of the same type. In 
addition to the operations already supported, this capability is now available for Pocketing and all Axial Machining 
operations. 

Power Option in Axial Operations 
This enhancement allows you to define the Power parameter for appropriate Axial machining operations. You can 
take the Power parameter value from the tool assembly (as in the previous Release) or you can define the Power 
parameter value specific to the operation. 

Helix Approach Macro in Circular Milling 
This enhancement provides capability to rough core the hole by Helical movement before a circular finishing path. 

Option to Disable Stock Management at Operation Level 
You can now choose to deactivate stock management for specific operations. The creation of the Output stock and/
or the handling of input stock in toolpath computation can be controlled at machining operation level. 
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Prismatic Machining Preparation Assistant Machining

Enhanced Functionalities

Axial Features Filter Capability 
This enhancement provides the capability to create machinable axial features based on user-defined filter criteria. 

Creating Machinable Axial Features and Machining Patterns 
This enhancement allows to include User parameters defined on holes in Machining Axial Feature as additional 
parameters. You can use these parameters as criteria to create Machining Pattern, or within formula and checks 
when defining Machining process. 
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STL Rapid Prototyping

New Functionalities

Working with Drafting
You can now generate drafting views and section cuts of meshes in exact mode.

Enhanced Functionalities

Export
You can define your own export format.

Import
GoCad (surfaces) and SRTM formats are now supported. 

Activate, Remove, Split
The Flood selection mode has been enhanced with an angle criterion.

Product Enhancement Overview Version 5 Release 20



3D Insight

3D Insight product is especially dedicated to collaborators who need to access and use the 3D product definition. It provides 
review capabilities (including 3D tolerancing and annotations review) and allows performing a precise analysis of the 
geometric product definition. 3D Insight does not allow to save and export the created/modified data in order to prevent 
any change of the 3D product definition.

3D Insight allows exact sectioning, exact measurement, sketch examination, construction and additional geometry creation 
for analysis, 3D Functional Tolerancing & Annotation (FTA) and 2D Layout for 3D Design (LO1) data review mark-up without 
the capability to save the created data and to export. It also allows performing geometric analysis of the product in context 
of the manufacturing/assembly/inspection tooling context.
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DMU Kinematics Simulator

Enhanced Functionalities

Managing the Mechanism Dressup
The dress-up definition is improved, the selection behavior is changed.
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Human Activity Analysis

New Functionalities

3D Display of Biomechanics Results
A better way to display the results in 3D, each segment results are highlighted in the list when the related segment 
in the 3D model is selected.

Defining Loads on Other Segments
This provides a more realistic behavior of the Biomechanics Analysis by allowing the use of loads positioned on 
segments other then just the hands. Therefore, Biomechanics Analysis can be applied on manikin having loads on 
shoulders, forearms and back.

Enhanced Functionality

Increased the number of analyzed joints - wrists
For a more complete analysis of the human biomechanics Results a new analysis will cover both wrists in flexion-
extension and Radial-Ulnar deviation.
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Human Builder

New Functionalities

Anthropometry - German, Chinese (Taiwan)
The anthropometry also includes German and Chinese (Taiwan).

Displaying Balance
This displays the support polygon of manikin's balance in the viewer. The color of the support polygon will change 
from green to red if the manikin loses his balance.

Defining the color of the Manikin Referential
Choosing the color of the manikin referential for each manikin enables the client to differentiate them and to make 
sure that it doesn't blend with the environment.

Auto Grasp Offset
The need for this highlight comes from wanting more control over an existing function that automatically generates 
a grasp posture of the hand by checking the collision between the hand and one or several objects to be grasped. 
A new option would allow you to edit the offset that control the reaching position of the hand which is currently 
automatically set to a default value.
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Human Measurements Editor

New Functionality

Anthropometry - German, Chinese (Taiwan)
The anthropometry also includes German and Chinese (Taiwan).
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